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Introduction

Networked computing and the emergence of collaborative technologies have 
dramatically increased the speed at which viruses spread in the corporate 
workplace. According to a Virus Prevalence Survey by the NCSA, over 99.3% 
of corporate networks had a virus outbreak within the last year.

Infected files in a network environment can rapidly escalate an individual user 
incident into a large-scale virus outbreak. The expense of cleaning a network-
based infection can be staggering. These expenses include: lost employee 
productivity, potential loss of data, internal help desk service costs, and addi-
tional network administrator and desktop service personnel support. These 
issues make server virus protection a must and during critical business cycles, 
could cost your company its edge.
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What is GroupShield?

McAfee’s GroupShield is a superior anti-virus solution for Microsoft Exchange 
servers. GroupShield combines McAfee’s award-winning Hunter virus scan-
ning technology with robust server management capabilities to minimize the 
virus threat within networks. Hunter scanning technology achieves superior 
virus detection by combining several virus analysis technologies. All PC virus 
types, including Word and Excel macro, boot sector, file, multi-partite, stealth, 
polymorphic, and encrypted viruses are detected. The Hunter engine even 
stops viruses written in Visual Basic 5.0, Office 95, and Office 97 file formats, 
providing maximum defense against the newest threats to data security.
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Main Features

Superior detection

� NCSA certified—McAfee participates in establishing virus identification 
standards with the National Computer Security Association.

� Includes the new Hunter scanning technology that combines several types 
of virus analysis technologies. 

� Hunter technology also stops viruses written in Visual Basic 5.0 and 
Office97 file formats, offering users maximum defense against the newest 
threats to data.

� Scans all PC virus types, including: Word and Excel macros, file infectors, 
multi-partite, stealth, polymorphic, and encrypted viruses. 

Automated protection

� Automatically cleans infected files without user or administrator interven-
tion. 

� Monitors public folders, databases, and mailboxes with minimal resource 
utilization.

� Flexible scheduling allows administrators to configure multiple scan tasks 
to run at different intervals.

� The Alert Manager’s advanced alerting features include pager notification, 
e-mail notification via SMTP, SNMP, and activity logging.

� Centralized Alerting enables administrators to receive alerts from worksta-
tions running VirusScan and notify the appropriate personnel via the Alert 
Manager.

� AutoUpdate feature allows for effortless updating of virus definition files for 
all servers running GroupShield.
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Administrative ease

� The powerful GroupShield Console makes configuring and administering 
GroupShield servers easy.

� Supports Windows NT services and file system.
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How To Contact McAfee

Customer service

To order products or obtain product information, we invite you to contact our 
Customer Care department by calling (408) 988-3832 or by writing to the 
following address:

McAfee Associates, Inc. 

2805 Bowers Avenue

Santa Clara, CA 95051-0963

U.S.A.

Technical support

McAfee is famous for its dedication to customer satisfaction. We have 
continued this tradition by making our site on the World Wide Web a valuable 
resource for answers to technical support issues. We encourage you to make 
this your first stop for answers to frequently asked questions, for updates to 
McAfee software, and for access to McAfee news and virus information.

If you do not find what you need or do not have web access, try one of our 
automated services.

World Wide Web http://www.mcafee.com

Automated Voice and Fax 
Response System

(408) 988-3034

Internet support@mcafee.com

McAfee BBS (408) 988-4004

1200 bps to 28,800 bps

8 bits, no parity, 1 stop bit

24 hours, 365 days a year

CompuServe GO MCAFEE

America Online keyword MCAFEE
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If the automated services do not have the answers you need, contact McAfee 
at one of the following numbers Monday through Friday between 6:00 A.M. and 
6:00 P.M. Pacific time.

For corporate-licensed customers:

For retail-licensed customers:

To provide the answers you need quickly and efficiently, the McAfee technical 
support staff needs some information about your computer and your software. 
Please have this information ready before you call:

� Product name and version number

� Computer brand and model

� Any additional hardware or peripherals connected to your computer

� Operating system type and version numbers

� Network type and version, if applicable

� Contents of your AUTOEXEC.BAT, CONFIG.SYS, and system LOGIN 
script

� Specific steps to reproduce the problem

McAfee training

For information about scheduling on-site training for any McAfee product, call 
(800) 338-8754.

Phone (408) 988-3832

Fax (408) 970-9727

Phone (972) 278-6100

Fax (408) 970-9727
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International contact information

To contact McAfee outside the United States, use the addresses and numbers 
below.

McAfee Canada

139 Main Street, Suite 201

Unionville, Ontario

Canada L3R 2G6

Phone: (905) 479-4189

Fax: (905) 479-4540

McAfee Europe B.V.

Gatwickstraat 25

1043 GL Amsterdam

The Netherlands

Phone: 31 20 586 6100

Fax:  31 20 586 6101

McAfee France S.A.

50 rue de Londres

75008 Paris

France

Phone: 33 1 44 908 737

Fax: 33 1 45 227 554

McAfee Deutschland GmbH

Industriestrasse 1

D-82110 Germering

Germany

Phone: 49 8989 43 5600

Fax: 49 8989 43 5699

McAfee (UK) Ltd.

Hayley House, London Road

Bracknell, Berkshire

RG12 2TH

United Kingdom

Phone: 44 1344 304 730

Fax: 44 1344 306 902

McAfee Japan Co, Ltd.

Toranomon 33 Mori Bldg.

3-8-21 Toranomon

Minato-Ku, Tokyo 105 

Japan

Phone: 81 3 5408 0700

Fax: 81 3 5408 0780
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Reporting new items for data file updates

McAfee is committed to providing you with effective and up-to-date tools you 
can use to protect your system. To that end, we invite you to report any new 
viruses that GroupShield does not now detect. Please note that McAfee 
reserves the right to use any information you supply as it deems appropriate, 
without incurring any obligations whatsoever. Send your suggestions to:

To report items to our European research office, use this e-mail address:

virus_research_europe@cc.mcafee.com

To report items to our Pacific Rim research office, or our office in Japan, use 
one of these e-mail addresses:

AVResearch@mcafee.com Use this address to report new virus 
strains.

avert-jp@ccj.mcafee.com Use this address to report harmful 
items to our office in Japan.

avert_apac@ccj.mcafee.com Use this address to report harmful 
items to our Pacific Rim office.
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Before You Start

Server requirements

� Windows NT Server, version 3.51 or later 

� Microsoft Exchange Server, version 4.0 or later

� At least 6.5MB of free disk space to install the program files

� Latest version of Microsoft Service Pack

" GroupShield is an NT service. No additional memory is required to run the 
software. However, the amount of system resources used varies. By spec-
ifying scanning priority for each task, you determine the amount of system 
resources the program uses.

Console requirements

� Windows NT Server version 3.51 or later or Windows NT Workstation ver-
sion 3.51 or later (for remote console administration of servers only)

� Microsoft Exchange Administrator

� Valid profile for connecting to the server

� At least 4.5MB of free disk space to install the program files
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Performing a Single Server Installation

To install GroupShield, complete the following procedure:

" The Microsoft Exchange Server and Client must be installed on the server 
prior to installing GroupShield. If you are also installing NetShield for Win-
dows NT on this server, it must be installed prior to GroupShield.

Step Action

1. Start the installation.

� Log on to the Windows NT server. You must have administrator 
security access to the Windows NT domain.

2. Do one of the following:

� If installing from the CD or diskettes, insert the CD or the first dis-
kette.

� If installing from files downloaded from the BBS, decompress the 
zipped files into a directory on the network or your local drive.

3. Double-click the SETUP.EXE program in Windows NT Explorer or File 
Manager or enter one of the following commands from the Windows 
NT command line prompt:

� If installing from the CD or diskettes, enter the following:

x:\SETUP

where x is the drive that contains the CD or diskette.

� If installing from files you downloaded from the McAfee Web Site, 
enter the following:

x:\path\SETUP

where x:path is the drive and directory where you decompressed 
the files.
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Response : The GroupShield License Agreement screen is displayed. 
Read it carefully before proceeding with the installation. 

4. Click OK to begin the installation.

Response : The GroupShield Welcome Screen is displayed.

5. Click Next.

Response : The Select Installation Type screen is displayed.

6. Select Single Server and click Next.

Response : The Setup Type screen is displayed. 

7. Select the destination directory for the GroupShield program files.

8. Select the type of installation:

� To install GroupShield with the most common options, select Typi-
cal and click Next.

� To configure GroupShield to use the fewest resources, select 
Compact and click Next.

� To perform a custom installation, select Custom and click Next. 
Select components to install and system options.

Response : The Service Account Usage screen is displayed. Click 
Next.

9. Select from the following:

� To use the system account, select Use The SYSTEM Account and 
click Next.

� To use a custom account, select Use This CUSTOM Account. 
Enter a password, reenter the password, and click Next.

Response : The Confirm Installation Settings screen is displayed.
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10. Confirm the installation options are correct and click Next.

Response : GroupShield begins copying files to the server. You are 
prompted to read the WHATSNEW.TXT file.

11. To view the file, click Yes. To skip the file, click No.

" Once installed, it is strongly recommended you read the Group-
Shield README.1ST and WHATSNEW.TXT files. These files con-
tain important last-minute and licensing information.

Response : The final screen is displayed.

12. Click Finish. 
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Performing a Multiple Server Installation

To install GroupShield on multiple servers, complete the following procedure:

" The Microsoft Exchange Server and Client must be installed on the servers 
prior to installing GroupShield. If you are also installing NetShield for Win-
dows NT on these servers, it must be installed prior to GroupShield.

1. Start the installation.

� Log on to the Windows NT server. You must have administrator 
security access to the Windows NT domain.

2. Do one of the following:

� If installing from the CD or diskettes, insert the CD or the first dis-
kette.

� If installing from files downloaded from the BBS, decompress the 
zipped files into a directory on the network or your local drive.

3. Double-click the SETUP.EXE program in File Manager or run one of 
the following commands from the Windows NT command line:

� If installing from the CD or diskettes, enter the following:

x:\SETUP

where x is the drive that contains the CD or diskette.

� If installing from files you downloaded from the McAfee Web Site, 
enter the following:

x:\path\SETUP

where x:path is the drive and directory where you decompressed 
the files.

Response : The GroupShield License Agreement screen is displayed. 
Read it carefully before proceeding with the installation. 
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4. Click OK to begin the installation.

Response : The GroupShield Welcome screen is displayed.

5. Click Next.

Response : The Select Installation Type screen is displayed.

6. Select Multiple Servers and click Next.

Response : The Select Network Servers screen is displayed.

7. Enter a server name or click Browse to locate one.

8. Click Add.

Response : The Remote Installation Information dialog box is dis-
played.

9. Select from the following:

� To use the system account, select Use The SYSTEM Account and 
click Next.

� To use a custom account, select Use This CUSTOM Account. 
Enter a password, reenter the password, and click Next.

10. Select from the following:

� To use the default path, select Use Default Path and click Next.

� To use a custom path, select Use This Custom Path, enter a path, 
and click Next.

Response : The Confirm Installation Settings screen is displayed.

11. Confirm the installation options are correct and click Next.

Response : GroupShield begins copying files to the servers. You are 
prompted to read the WHATSNEW.TXT file.
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12. To view the file, click Yes. To skip the file, click No.

" Once installed, it is strongly recommended you read the Group-
Shield README.1ST and WHATSNEW.TXT files. These files con-
tain important last-minute and licensing information.

Response : The final screen is displayed.

13. Click Finish. 
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Starting the GroupShield Console

To start the GroupShield Console, complete one of the following procedures:

� Click Start, point to Programs, point to McAfee GroupShield, and click 
GroupShield Console (Windows NT 4.x).

� From the Program Manager, open the McAfee GroupShield group and 
double-click the GroupShield Console icon (Windows NT 3.5x).

Figure 3-1. GroupShield Console

The GroupShield Console (Figure 3-1) consists of the menu bar, the toolbar, 
and the task display area.

" For information on using the Console, see Chapter 4, “Using the Console”.
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The menu bar

The menu bar contains the following menus and menu commands:

Task Edit View Tools Help 

New Task Copy Toolbar Connect to
Computer

Online Virus 
InfoLibrary

Enable/
Disable/Start

Paste Status bar Disconnect from 
Computer

 Help Topics

Rename Refresh Virus List About

Delete Options AutoUpdate

Statistics Alerts

Activity Log Event Viewer

Properties

Exit
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The toolbar 

The toolbar contains the following buttons:

Tool Description (Corresponding Menu/Command)

Connects to a computer (Tools/Connect to Computer).

Disconnects from a computer (Tools/Disconnect from 
Computer).

Creates a new task (Scan/New Task).

Edits a task’s properties (Scan/Properties).

Copies a task (Edit/Copy).

Pastes a task (Edit/Paste).

Removes a task from the Console (Edit/Delete).

Starts the selected task (Scan/Start and Scan/Enable).

Stops the selected task (Scan/Stop and Scan/Disable).

Views the virus list (Tools/Virus List).

Open the Windows NT Event Viewer (Tools/Event Viewer).
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The task display area

The task display area is the main part of the Console containing all defined 
tasks. The on-access task is always shown at the top of the display area.

Other tasks appear as you create them. To create a new on-demand task, see 
“Creating an on-demand task” on page 36.

To edit the on-access task, see “Editing the on-access task” on page 28. 

" To display a task’s statistics, double-click the task or highlight the task and 
select Statistics from the Scan menu.

Changing Computers

When the GroupShield Console is started, the name of the server it is con-
nected to is displayed on the Console title bar (unless you are running the Con-
sole on the server being configured). To change computers, complete the 
following procedure:

Step Action

1. Click  or choose Connect to Computer from the Tools menu.

Response : The Connect to Remote Computer dialog box is displayed 
(Figure 3-2).

Figure 3-2. Connect to Remote Computer Dialog Box
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2. Enter the UNC name of a server or click Browse to locate a server.

" The target server must have the GroupShield Server software 
installed.

3. Click OK.

Response : The name of the new server is displayed in the Console 
title bar and any configured tasks are listed in the Console task window 
(tasks for other servers disappear). If the Console does not success-
fully log on to the server, confirm GroupShield is installed.
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Most of the functionality of GroupShield is built into the Console. From the Con-
sole, you can configure and schedule tasks that monitor the server or scan 
public folders, databases, and mailboxes.

What is a Task?

A task is a saved GroupShield configuration which, once created, can be run 
as often as you like. Tasks (on-demand only) can be copied and pasted on the 
same server or shared between servers.

There are two types of tasks: on-access tasks and on-demand tasks.

The on-access task monitors the server. It monitors mail attachments, data-
bases, and public folders. The administrator can specify what types of files and 
file attachments are scanned and how GroupShield responds. For information 
on editing the on-access task, see “Editing the on-access task” on page 28.

On-demand tasks are tasks that may be configured to scan all or specific pub-
lic folders, databases, or mailboxes. The administrator may specify which mail-
boxes, databases or public folders are scanned, how often a scan takes place, 
and how GroupShield responds. For information on creating an on-demand 
task, see “Creating an on-demand task” on page 36.
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The On-access Task

Editing the on-access task

The on-access task is listed in the Console task window and is preceded by a 
shield . Although the on-access task can be disabled, it cannot be deleted.

To edit the name of the on-access task, highlight the text with your mouse and 
type a new name over “GroupShield On-Access Task”.

To edit the on-access task, do one of the following: 

� Highlight the task and click .

� Highlight the task and select Properties from the File menu

� Right-click the task and select Properties from the shortcut menu. 

Response : The GroupShield property sheet appears with the Detec-
tion page showing (Figure 4-1). 

Figure 4-1. GroupShield  Properties Window
(Detection Property Page)
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Choosing which files and file attachments are scanned

To select which file types are scanned and scanning options, complete the fol-
lowing procedure:

Step Action

1. Click the Detection tab of the GroupShield Properties window.

Response : The Detection property page appears (Figure 4-1).

2. Select the types of files and file attachments to scan:

� To scan all files and file attachments, select Scan All Files Attach-
ments. Skip to Step 3.

� To scan files and file attachments with specific extensions, select 
Scan Only Attachments of Type and click the Extensions button.

Response : The Program File Extensions dialog box appears 
(Figure 4-2).

Figure 4-2. Program File Extensions Dialog Box

� To add a file type to scan, click Add. Enter a new file extension 
and click OK. Repeat this procedure until all desired file exten-
sions are entered.

� To delete an extension, highlight it and click Delete.

� To return to the default extensions, click Default.
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When you are finished editing the list of file extensions, click OK. To 
exit without saving, click Cancel.

3. To include compressed files and file attachments, select the Com-
pressed Files checkbox.

" Compressed files include PKZIP and LHA files.

4. To automatically start GroupShield each time the server is started, 
select the Enable On-access Scanning at System Startup checkbox.

" To manually start or stop the GroupShield Service, use the Ser-
vices Manager located in the Control Panel. For more information, 
refer to the documentation which accompanied Microsoft NT.

5. To allow disabling of the on-access task from the Console, select the 
GroupShield Can Be Disabled checkbox.

6. To display the GroupShield Icon on the taskbar, select the Show 
GroupShield Icon on the Taskbar checkbox.

" Double-clicking the GroupShield Icon opens the GroupShield 
Properties window.

7. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.

Setting how GroupShield responds to a virus infection

To control how GroupShield responds to a virus detection, complete the follow-
ing procedure:

Step Action

1. Click the Actions tab of the GroupShield Properties window.
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Response : The Actions property page appears (Figure 4-3). 

Figure 4-3. GroupShield  Properties Window 
(Actions Property Page)

2. Select how GroupShield will respond to any viruses encountered. 
GroupShield can respond by:

� Cleaning infected attachments automatically

If a virus cannot be removed from a file or the file is damaged 
beyond repair, GroupShield logs the infection and continues moni-
toring the server. To prevent additional infection, make sure to 
enable activity logging and alerting features. See “Creating a virus 
activity log” on page 33 and Chapter 5, “Virus Notification.”

To configure GroupShield to delete the infected attachment if the 
file cannot be cleaned, select the Delete Attachment if Specified 
Action Fails checkbox.

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.
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� Deleting infected attachments automatically

If this option is selected, confirm that activity logging is enabled. 
This will ensure you have a record of which files and file attach-
ments were deleted. See “Creating a virus activity log” on page 33.

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.

� Moving infected attachments automatically

If this option is selected, make sure to enable activity logging. This 
will ensure you have a record of which files and file attachments 
were moved. See “Creating a virus activity log” on page 33.

To configure GroupShield to delete the infected attachment if the 
file cannot be moved, select the Delete Attachment if Specified 
Action Fails checkbox.

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.

� Logging the infection and continuing scanning

Since no action is taken, this option is not recommended for most 
applications. If this option is selected, make sure to enable activity 
logging and alerting features. This will enable you to locate which 
files and file attachments are infected. See “Creating a virus activ-
ity log” on page 33 and Chapter 5, “Virus Notification.”

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.

3. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.
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Creating a virus activity log

The virus activity log keeps track of all relevant GroupShield activity, including 
virus detection, virus cleaning, infected file and file attachment deletion, 
infected file and file attachment move, and session settings.

To configure the log file, complete the following procedure:

Step Action

1. Click the Reports tab of the GroupShield Properties Window.

Response : The Reports property page appears (Figure 4-4).

Figure 4-4. GroupShield Properties Window
(Reports Property Page)

2. Select the Log To File checkbox. To choose a new log file location and 
log file name, click Browse.

3. To limit the size of the log file, select the Limit Size checkbox and enter 
the maximum file size (in kilobytes).

4. Select which types of activity to include in the log file. 
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To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.

Excluding public folders, databases, and mailboxes from 
monitoring

GroupShield can be configured to exclude specified public folders, databases, 
and mailboxes from monitoring.

" If you configured GroupShield to automatically move infected files and file 
attachments to a folder, the folder is automatically excluded from scanning.

To exclude folders from being scanned, complete the following procedure:

Step Action

1. Click the Exclusion tab of the GroupShield Properties window.

Response : The Exclusion property page appears (Figure 4-5). 

Figure 4-5. GroupShield Properties Window 
(Exclusions Property Page)
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2. To add an item to exclude from scanning, click Add.

Response : The Browse Server dialog box appears (Figure 4-6). 

Figure 4-6. Exclude Item Dialog Box

3. Select from the following:

� To exclude a mailbox, open the Recipients tree and select a user. 
Use the checkboxes to choose whether you want to exclude the 
inbox, the outbox, sent items, deleted items, or other items.

� To exclude a public folder, open the Public Folders tree and select 
a folder. To exclude subfolders, select the Include Subfolders 
checkbox.

4. Click OK.

5. Repeat Step 2 through 4 until all items to exclude are entered.

6. To edit an item, highlight the item and click Edit.

7. To delete an item, highlight the item and click Remove.

8. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.
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On-demand Tasks

Creating an on-demand task

To create a new on-demand task, click  or select New Task from the 
Scan menu. A new on-demand task is listed in the Console task window.

Editing an on-demand task

To edit the name of the on-demand task, highlight the text with your mouse and 
type a new name over “New Scan Task.”

To edit the properties of the on-demand task, highlight the task and click  
or right-click the task and select Properties from the shortcut menu. The Task 
Properties window appears with the Detection page showing (Figure 4-7).

Figure 4-7. Task Properties Window 
(Detection Property Page)
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Choosing file types and locations for scanning

To choose which files and file attachments are scanned, complete the following 
procedure:

Step Action

1. Click the Detection tab of the Task Properties sheet.

Response : The Detection page appears (Figure 4-7).

2. To scan all public folders, databases, and mailboxes, select Scan All 
Mailboxes, Databases, and Public Folders.

3. To scan specific locations, select Scan Specific Locations and click 
Add.

Response : The Browse Exchange Folders dialog box appears 
(Figure 4-8).

Figure 4-8. Add Scan Item Dialog Box
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4. Select from the following:

� To scan a mailbox, open the Recipients tree and select a user. 
Use the checkboxes to choose whether you want to scan the 
inbox, the outbox, sent items, deleted items, or other items.

� To scan a public folder, open the Public Folders tree and select a 
folder. To scan subfolders, select the Include Subfolders check-
box.

5. Click OK.

6. To add more scan items, repeat Step 3 through Step 5.

7. Select the types of files and file attachments to scan:

� To scan all files and file attachments, select Scan All Files Attach-
ments. Skip to the next step.

� To scan files and file attachments with specific extensions, select 
the Scan Only Attachments of Type and click the Extensions but-
ton.

Response : The Extensions dialog box appears (Figure 4-9).

Figure 4-9. Program File Extensions Dialog Box

� To add a file extension, click Add. Enter the new file extension 
and click OK. Repeat this procedure until all extensions are 
entered.

� To delete an extension, highlight it and click Remove.

� To return to the default extensions, click Default.
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When you are finished editing the list of file extensions, click OK.

8. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.

Setting how GroupShield responds to a virus infection

To control how GroupShield responds to a virus infection, complete the follow-
ing procedure:

Step Action

1. Click the Actions tab of the Task Properties window.

Response : The Actions property page appears (Figure 4-10).

Figure 4-10. Task Properties Window 
(Actions Property Page)
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2. Select how GroupShield responds to any viruses encountered. Group-
Shield can respond by:

� Cleaning infected attachments automatically

If a virus cannot be removed from a file or the file is damaged 
beyond repair, GroupShield logs the infection and continues moni-
toring the server. To prevent additional infection, make sure to 
enable activity logging and alerting features. See “Creating a virus 
activity log” on page 33 and Chapter 5, “Virus Notification.”

To configure GroupShield to delete the infected attachment if the 
file cannot be cleaned, select the Delete Attachment if Specified 
Action Fails checkbox.

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.

� Deleting infected attachments automatically

If this option is selected, confirm that activity logging is enabled. 
This will ensure you have a record of which files and file attach-
ments were deleted. See “Creating a virus activity log” on page 33.

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.

� Moving infected attachments automatically

If this option is selected, make sure to enable activity logging. This 
will ensure you have a record of which files and file attachments 
were moved. See “Creating a virus activity log” on page 33.

To configure GroupShield to delete the infected attachment if the 
file cannot be moved, select the Delete Attachment if Specified 
Action Fails checkbox.

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts” on 
page 61.
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� Logging the infection and continuing scanning

Since no action is taken, this option is not recommended for most 
applications. If this option is selected, make sure to enable activity 
logging and alerting features. This will enable you to locate which 
files and file attachments are infected. See “Creating a virus activ-
ity log” on page 33 and Chapter 5, “Virus Notification.”

To inform the sender and recipient of an infected file attachment, 
use mail alert messages. See “Configuring Mail Alerts”.

3. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.

Excluding folders from being scanned

To exclude public folders, databases, and mailboxes from being scanned, 
complete the following procedure:

Step Action

1. Click the Exclusion tab of the Task Properties window.

Response : The Exclusion property page appears (Figure 4-11).

Figure 4-11. GroupShield Properties Window 
(Exclusions Property Page)
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2. To add an item to exclude from scanning, click Add.

Response : The Browse Server dialog box appears (Figure 4-12). 

Figure 4-12. Exclude Item Dialog Box

3. Select from the following:

� To exclude a mailbox, open the Recipients tree and select a user. 
Use the checkboxes to choose whether you want to exclude the 
inbox, the outbox, sent items, deleted items, or other items.

� To exclude a public folder, open the Public Folders tree and select 
a folder. To exclude subfolders, select the Include Subfolders 
checkbox.

4. Click OK.

5. Repeat Step 2 through 4 until all items to exclude are entered.

6. To edit an item, highlight the item and click Edit.

7. To delete an item, highlight the item and click Remove.

8. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.
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Creating a virus activity log

The virus activity log keeps track of all relevant GroupShield activity, including 
virus detection, virus cleaning, infected file deletion, infected file move, and 
session settings.

To configure the log file, complete the following procedure:

Step Action

1. Click the Reports tab of the Task Properties window.

Response : The Reports property page appears (Figure 4-13).

Figure 4-13. Task Properties Window
(Reports Property Page)

2. Select the Log To File checkbox. To choose a new log file location and 
log file name, click Browse.

3. To limit the size of the log file, select the Limit Size checkbox and enter 
the maximum file size (in kilobytes).

4. Select which types of activity to include in the log file. 
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5. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.

Scheduling an on-demand task

Decide how often to run the task:

� Once

� Hourly

� Daily

� Weekly

� Monthly

� Each time the server is started

To schedule a scan, complete the following procedure:

Step Action

1. Click the Schedule tab of the Task Properties window.

Response : The Schedule property page appears (Figure 4-14).

Figure 4-14. Task Properties Window
(Schedule Property Page)
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2. Select the Enable Scheduler checkbox.

3. Select how often the task will run:

� To schedule a one-time scan, select the Once option and enter the 
time and date.

� To schedule an hourly scan, select the Hourly option. Set the task 
to start X minutes after the hour where X is a number between 0 
and 59. For example, to set the scan to occur 30 minutes after 
every hour (8:30, 9:30, 10:30, etc.), select Hourly button and enter 
30.

� To schedule the scan for specific days, select the Daily option. 
Enter the time for the scan to start, and click the Which Days but-
ton.

Response : The Select Days to Scan dialog box appears 
(Figure 4-15).

Figure 4-15. Select Days To Scan Dialog Box

Action : Choose which days the scan will run. Click OK.

� To schedule a weekly scan, select the Weekly option and enter the 
time and day of the week for the scan to start.

� To schedule a monthly scan, select the Monthly option and enter 
the time and day of the month for the scan to start.

� To schedule a scan every time the server is started, select the At 
Startup option.

4. Click OK.
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5. To further configure this task, select another property page. To save 
the changes and return to the Console, click OK. To cancel any 
changes and return to the Console, click Cancel.

Working with Tasks

GroupShield is designed to be easy-to-use and flexible. This section describes 
many of the features that enable you to view task statistics, import and export 
tasks, and copy and paste tasks.

Working with the Statistics window

The Statistics window displays a task’s current status and statistics on files and 
file attachments scanned. To open the Statistics window, double-click a task or 
highlight a task and select Statistics from the Scan menu.

Copying and pasting tasks

To configure multiple servers and save time, GroupShield supports the copying 
and pasting of tasks. To copy a task, complete the following procedure:

Step Action

1. Highlight the task to copy and click  or select Copy from the Edit 
menu.

2. Complete one of the following:

� To copy the task to this server, continue to the next step.

� To copy the task to another server, connect to the server. For infor-
mation on connecting to another server, see “Changing Comput-
ers” on page 25.

3. Click  or select Paste from the Edit menu.

Response : The task is copied and appears in the Console window.
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4. Enter a name for the task and press Enter.

Response : The Task Properties sheet appears.

5. Make any necessary changes to the task and click OK.

" Only on-demand tasks may be copied. The on-access task cannot be cop-
ied.

Disabling tasks

Disabling the on-access task

To disable the on-access task, highlight the task and select Disable from the 
Scan menu.

Disabling on-demand tasks

To disable an on-demand task without deleting, deselect the Enable Scheduler 
checkbox on the Schedule page. For information about using the scheduler, 
see “Scheduling an on-demand task” on page 44.

Deleting tasks

Deleting the on-access task

The on-access task cannot be deleted. To disable the on-access task, see 
“Disabling the on-access task” on page 47. To change the properties of the on-
access task, see “Editing the on-access task” on page 28.

Deleting on-demand tasks

To delete an on-demand task, highlight a task and select Delete from the Scan 
menu.
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5Virus Notification

In addition to automatically responding to viruses (cleaning, deleting, moving, 
etc.), GroupShield may be configured to run a program on virus detection, 
maintain virus information in an event log, receive virus activity alerts from 
users running VirusScan, and alert personnel of server virus activity (through 
pagers, printers, e-mail, etc.).

� To configure GroupShield to alert personnel of virus activity through pag-
ers, printers, e-mail, etc., see “Using Alert Manager” on page 49.

� To configure GroupShield to execute a program on alert, see “Executing a 
Program on Alert” on page 59.

� To configure GroupShield to send mail alert messages to message send-
ers and message recipients, see “Configuring Mail Alerts” on page 61.

� To customize alert message text and priority levels, see “Customizing 
Alerts” on page 64.

� To configure GroupShield to use Centralized Alerting to report virus activity 
from workstations, see “Using Centralized Alerting” on page 67.
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To open the Alert Properties window, select Alerts from the Tools menu 
(Figure 5-1). 

Figure 5-1. Alert Properties Window
(System Alerts Property Page)

Using Alert Manager

Use the Alert Manager to send alert notifications to computers, e-mail 
addresses, pagers, or printers. 

GroupShield supports the use of any combination of notification methods and 
multiples of each. To send additional alerts, use Forward to send alerts to 
another GroupShield server. Whenever the server receives a Forward, it sends 
notifications to all of the recipients listed in its summary page. 

" In large organizations, use Forward to send alerts to centralized notifica-
tion systems or to MIS departments to keep track of virus statistics and 
problem areas.

To open the Alert Manager, complete the following procedure:
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Step Action

1. Select Alerts from the Tools menu.

2. From the System Alerts property page, select the Use McAfee Alert 
Manager checkbox and click Configure.

Response : The Alert Manager Properties window appears with the 
Summary page showing (Figure 5-2).

Figure 5-2. Alert Manager Properties Window
(Summary Property Page)

Summary page

The Summary page lists all alert notification items configured on the other 
property pages.

� To view the properties of a notification item, highlight the item and click 
Properties.

� To delete a notification item, highlight the item and click Remove.
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Forwarding alerts to another server

GroupShield can forward alerts to another server. The server receiving the for-
warded message then sends alerts to recipients listed in the Summary page of 
its Alert Manager property sheet.

" The McAfee Alert Manager Service must be running on both the system 
sending the Forward and the system receiving the Forward.

Step Action

1. Open the Alert Manager properties window.

2. Select the Forward tab.

Response : The Forward property page appears with a list of all serv-
ers configured to receive forwarded messages.

3. To add a server to receive Forwards, click Add.

4. Specify a server or click Browse to locate the server.

5. To test the Forward, click Test.

Response : The server receives a test message.

6. To set the priority level of the messages this server receives, click Pri-
ority Alerts.

� To set the server to receive low, medium, and high priority alerts, 
select Low.

� To set the server to receive medium and high priority alerts, select 
Medium. 

� To set the server to receive high priority alerts only, select High.

" Configure High Priority items to be forwarded to other computers. 
This increases the number of alert notifications sent in an urgent 
situation and improves the chances of someone responding to the 
problem quickly.
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7. Click OK.

8. To add another server to receive forwarded alerts, click Add. 

9. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

Sending a network message

The Alert Manager supports the sending of network messages to specified 
computers. To send alert notifications via network messages, complete the fol-
lowing procedure:

" To receive messages on Windows 95 machines, you must be running Win-
Popup.

Step Action

1. Open the Alert Manager properties window.

2. Select the Network Message tab.

Response : The Network Message property page appears with a list of 
all computers configured to receive network messages.

3. To add a computer to receive network message alert notifications, click 
Add.

4. Enter the computer to receive network messages or click Browse to 
locate the computer.

5. To test the connection, click Test.

Response : The message recipient receives a test message.
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6. To set the priority level of the messages this computer receives, click 
Priority Alerts.

� To set the computer to receive low, medium, and high priority 
alerts, select Low.

� To set the computer to receive medium and high priority alerts, 
select Medium. 

� To set the computer to receive high priority alerts only, select High.

7. Click OK.

8. To add another computer to receive network message alert notifica-
tions, click Add. 

9. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

Sending an alert to an e-mail address

The Alert Manager supports the sending of e-mail messages. To send alert 
notifications via e-mail, complete the following procedure:

Step Action

1. Open the Alert Manager properties window.

2. Select the E-Mail tab.

Response : The E-Mail property page appears with a list of e-mail 
addresses configured to receive alert notifications.
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3. To add an e-mail address, click Add.

Enter an e-mail address. The format of the address is 
<user>@<workgroup> (e.g. johndoe@mcafee.com).

Fill out the Subject line.

Fill out the From line.

4. To configure SMTP settings, click Configure SMTP, enter the Domain 
name or IP address, Server name, and Login name.

5. To test the connection, click Test.

Response : The message recipient receives a test message.

6. To set the priority level of the messages this e-mail address receives, 
click Priority Alerts.

� To set the address to receive low, medium, and high priority alerts, 
select Low.

� To set the address to receive medium and high priority alerts, 
select Medium. 

� To set the address to receive high priority alerts only, select High.

7. Click OK. To add another recipient to receive alert notifications, click 
Add. 

8. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

Sending an alert to a pager

The Alert Manager supports the sending of alert notifications to alphanumeric 
and numeric pagers.
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" To send pager notifications, a modem must be installed in the GroupShield 
server. If the server does not have a modem, send a Forward to a modem-
equipped GroupShield server.

Alphanumeric pager

To send alert notifications to an alphanumeric pager, complete the following 
procedure:

Step Action

1. Open the Alert Manager properties window.

2. Select the Pager tab.

Response : The Pager property page appears with a list of all pagers 
configured to receive alert notifications.

3. To add a pager, click Add.

4. Select Alphanumeric Pager.

5. Enter the pager phone number, an ID number or PIN (if applicable), 
and a password (if applicable).

6. To use the standard alert message, select the Use Standard Alert 
Message option.

To use a custom message, select the Use Custom Alert Message 
option and enter a message.

7. To configure the modem settings, click Modem.

8. To test the pager, click Test.

9. To set the priority level of alert notifications this pager receives, click 
Priority Alerts.

� To set the pager to receive low, medium, and high priority alerts, 
select Low.
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� To set the pager to receive medium and high priority alerts, select 
Medium. 

� To set the pager to receive high priority alerts only, select High.

10. Click OK.

11. To add another pager to receive notifications, repeat steps 3 through 
10. 

12. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

Numeric pager

To send alert notifications to a numeric pager, complete the following proce-
dure:

Step Action

1. Open the Alert Manager properties window.

2. Select the Pager tab.

Response : The Pager property page appears with a list of all pagers 
configured to receive alert notifications.

3. To add a pager, click Add.

4. Select Numeric pager.

5. Enter the pager phone number.

6. Enter a numeric message.

7. Enter the delay time between dialing and sending the alert message.

8. To configure the modem settings, click Modem.
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9. To test the pager, click Test.

10. To set the priority level of alert notifications this pager receives, click 
Priority Alerts.

� To set the pager to receive low, medium, and high priority alerts, 
select Low.

� To set the pager to receive medium and high priority alerts, select 
Medium. 

� To set the pager to receive high priority alerts only, select High.

11. Click OK.

12. To add another pager to receive notifications, repeat steps 3 through 
11. 

13. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

Sending an alert to a printer

The Alert Manager supports the sending of alert notifications to printers. To 
send alert notifications to printers, complete the following procedure:

Step Action

1. Open the Alert Manager properties window.

2. Select the Printer tab.

Response : The Printer property page appears with a list of all systems 
currently configured to receive alert notifications.

3. To add a printer, click Add.

4. Enter a printer location or click Browse to locate the printer.
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5. To test the connection, click Test.

Response : The printer prints a test message.

6. To set the priority level of the messages this printer receives, click Pri-
ority Alerts.

� To set the printer to receive low, medium, and high priority alerts, 
select Low.

� To set the printer to receive medium and high priority alerts, select 
Medium. 

� To set the printer to receive high priority alerts only, select High.

7. Click OK.

8. To add another printer to receive alert notifications, click Add. 

9. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

" The printer must be configured by the Print Manager prior to configuring 
this notification option. 

Using SNMP

GroupShield supports the sending of SNMP (Simple Network Management 
Protocol) traps. To enable SNMP, complete the following procedure:

Step Action

1. Open the Alert Manager property sheet.

2. Select the SNMP tab.

Response : The SNMP property page appears.

3. Select the Enable SNMP checkbox.
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4. To configure SNMP services, click Configure.

Response : The Microsoft NT Network Settings property sheet 
appears.

5. To complete configuration of SNMP services, refer to the operating 
system documentation. 

6. To configure other notification options, select another property page. 
To save the changes and exit, click OK. To cancel any changes, click 
Cancel.

Executing a Program on Alert

In the event Alert Manager does not meet your needs, it may be configured to 
launch any program or batch file on alert. For example, if your company is 
using cc:Mail or a special mail package, you could write a batch file to send 
notifications to your mail package.

" Any program launched on alert runs in the background without a visible 
user interface.

To configure GroupShield to execute a program on alert, complete the follow-
ing procedure:

Step Action

1. Select Alerts from the Tools menu.

2. Select the Execute Program on Alert checkbox.

3. Enter the name and path of the program to execute or click Browse to 
locate the program.

4. To execute the program every time an alert event occurs, select the 
Every Time option. To execute the program on the first alert event 
only, select the First Time option.

5. To save the changes and return to the console, click OK. To cancel 
any changes, click Cancel. 
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Logging Alerts

To configure GroupShield to log alerts in the Windows application log, com-
plete the following procedure:

" To ensure this feature functions properly, see “Security Considerations and 
Requirements of NT Services” in the Windows NT documentation.

Step Action

1. Select Alerts from the Tools menu.

2. Select the Log Alert in Event Log checkbox.

3. To log alert events in the local computer’s event log, click the Use 
Local Computer’s Event Log option button.

4. To log alert events in another computer’s event log, click the Use 
Another Computer’s Event Log option button. Click Browse to locate 
the computer.

5. Click OK. 

Response : Alert events are stored in the Event Log.

" To open the application log, click or select Event Log from the Tools 
menu.
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Configuring Mail Alerts

To inform message senders, message recipients, and the Administrator of 
infected attachments, GroupShield supports the sending of mail alert mes-
sages. 

Mail alert messages make users aware. If a file attachment is sent and Group-
Shield is configured to move the infected attachment to a quarantine folder, the 
sender and the recipient will know why the file did not successfully reach its 
destination. Or, if a file attachment is sent and GroupShield unsuccessfully 
attempts to clean the virus, the recipient will know there is a live virus in their 
mailbox.

Mail alert messages are a very important part of virus prevention. Once a mes-
sage sender is made aware of the infected file attachments, the user could use 
a VirusScan desktop product, clean any other infected files, and prevent addi-
tional infection.

To configure GroupShield to send mail alert messages, complete the following 
procedure:

" While an alert message can be customized, the cause of the alert does not 
change (e.g. when a task starts, the ‘task has started’ message is gener-
ated). Be careful not to modify the meaning of the alert message. Other-
wise, notifications may become confusing or erroneous.

1. Select Alerts from the Tools menu.

Response : The Alert Properties Window appears with the System 
Alerts page showing.

2. Click the MAPI Messages Tab.
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Response : The MAPI Message page appears (Figure 5-3).

Figure 5-3. Alert Properties Window (MAPI Messages Page)

3. Select a message to configure and click Edit.

Response : The Configure Mail Alert Message dialog box appears 
(Figure 5-4).

Figure 5-4. Configure Mail Alert Message dialog box
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4. Select Sender from the Select Alert Recipient drop-down box.

5. To enable or disable this alert for the selected recipient, select or dese-
lect the Enable Alert for the Selected Recipient checkbox. If you dese-
lected this checkbox, skip to Step 7.

6. To modify the message, edit the text in the Message text box.

" GroupShield supports the use of alert message variables. For 
more information, see “Alert Message Variables” on page 93.

7. Select Recipient from the Select Alert Recipient drop-down box. 
Repeat Step 5 and 6.

8. Select Administrator from the Select Alert Recipient drop-down box. 
Repeat Step 5 and 6.

9. When you are finished modifying this message, click OK. To close this 
dialog box without saving any changes, click Cancel.

Response : You are returned to the MAPI Messages page.

10. Repeat Steps 2 through  9 for each message.
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Customizing Alerts

Enabling/disabling alerts

To enable and disable alerts, complete the following procedure:

Step Action

1. Select Alerts from the Tools menu and click the Messages tab.

Response : The Alert Properties window appears with the Messages 
page showing (Figure 5-5). 

Figure 5-5. Alert Properties Window 
(Messages Page)

2. To enable an alert, select its checkbox.

3. To disable an alert, deselect its checkbox.

4. To save the changes and exit, click OK. To exit without saving 
changes, click Cancel.
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Changing the priority of an alert

To change the priority level of an alert, complete the following procedure:

Step Action

1. Select Alerts from the Tools menu and click the Messages tab.

Response : The Alert Properties window appears (Figure 5-5) with the 
Messages page showing.

2. Highlight an alert and click Edit.

Response : The Configure System Message dialog box appears 
(Figure 5-6).

Figure 5-6. Configure System Message Dialog Box

3. Select a priority level.

4. Click OK.
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Customizing an alert message

To customize an alert message, complete the following procedure:

" While an alert message can be customized, the cause of the alert does not 
change (e.g. when a task starts, the ‘task has started’ message is gener-
ated). Be careful not to modify the meaning of the alert message. Other-
wise, notifications may become confusing or erroneous.

Step Action

1. Select Alerts from the Tools menu and click the Messages tab.

Response : The Alert properties window appears (Figure 5-5) with the 
Messages page showing.

2. Highlight an alert and click Edit.

Response : The Configure System Message dialog box appears 
(Figure 5-6).

3. Enter a custom message in the text field.

" GroupShield supports the use of alert message variables. For 
more information, see “Alert Message Variables” on page 93.

4. Click OK.
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Using Centralized Alerting

Centralized Alerting is a powerful feature for alerting the appropriate personnel 
of workstation virus activity. Once Centralized Alerting is enabled and config-
ured, workstations using VirusScan report virus activity to GroupShield serv-
ers. GroupShield then notifies the appropriate personnel (through pagers, 
printers, e-mail, fax, etc.) listed in the Alert Manager Summary page. To config-
ure the Alert Manager, see “Using Alert Manager” on page 49.

How Centralized Alerting works

The GroupShield server is configured to monitor an Alert Folder where all 
users have create, write, and delete rights. When a virus event occurs on a 
workstation, the workstation sends a Centralized Alerting file to the server’s 
Alert Folder. The server then reads the file and notifies the appropriate person-
nel specified in the Alert Manager.

" For information on the Centralized Alerting file format, see “Centralized 
Alerting ALR File Format” on page 94.

Configuring Centralized Alerting

To configure Centralized Alerting, complete the following procedure:

Step Action

1. Select Alerts from the Tools menu.

Response : The Alert Properties window appears (Figure 5-5 on page 
64).

2. Select Enable Centralized Alerting.

3. Enter the location of the Alert Folder or click Browse to select one.

" All users must have create, write, and delete rights to the Alert 
Folder.
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" If VirusScan for Windows 3.1x or VirusScan for DOS workstations 
are using Centralized Alerting to report virus activity to this server, 
you should use a folder name that has eight characters or less 
(e.g. c:\central).

4. Click OK.

Response : GroupShield is ready to receive alerts.

5. Configure any desktop machines which will report virus activity. For 
more information, refer to the documentation which accompanied 
VirusScan.
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Overview: AutoUpdate

Approximately once a month, McAfee updates the GroupShield data (DAT) 
files. To distribute these files, a multi-line bulletin board system, a forum on 
CompuServe, and an Internet node are available. For more information on 
obtaining DAT files, see “Updating Virus Definition Files” on page 84.

" AutoUpdate is a powerful feature that can ensure you always have the lat-
est version of the anti-virus data files on your systems. AutoUpdate can 
automatically download updates from an ftp site or network distribution 
site. After the update is downloaded, AutoUpdate can post the update to a 
distribution site for downloading by other computers. Obtaining updates 
from outside the network typically requires the writing of a shell script. The 
script included with GroupShield is only a sample and must be modified to 
suit your needs.
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How AutoUpdate works

When AutoUpdate runs, it looks for a file named VERSION.DAT. This file con-
tains the following information:

When AutoUpdate locates VERSION.DAT, it determines whether the update is 
needed and if your version of GroupShield is current enough to use the update.

� If the update is not required, AutoUpdate sends you a No Update Required 
message.

� If your version of GroupShield is not current enough to use the update, 
AutoUpdate informs you that you need to upgrade your version of Group-
Shield to qualify for the update. To upgrade your version, visit the McAfee 
Web Site. See “How To Contact McAfee” on page 11.

� If the update is needed, AutoUpdate executes the file specified by VER-
SION.DAT. 

[GroupShield] Designates the product to which this file applies.

uVersion=X X is the version of the new update.

uVersionreq=Y Y is the version required to use this update.

szUpdateMod-
ule=FILENAME

FILENAME is the name of the file which will be 
retrieved and executed.
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Obtaining an Update

To obtain an update using AutoUpdate, complete the following procedure:

Step Action

1. Select AutoUpdate from the Tools menu.

Response : The AutoUpdate Properties sheet appears with the Update 
Location page showing (Figure 6-1).

Figure 6-1. AutoUpdate Properties Window

2. Complete one of the following steps:

� To obtain the update using a shell script, click the Obtain Update 
Module Using Shell Script option button. Enter the location of the 
shell script or click Browse to choose a location.

� To obtain the update from a distribution site, click the Copy Update 
Module From option button. Enter the full path to the location of the 
update module and VERSION.DAT.
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3. After AutoUpdate downloads an update, it can store a copy of the 
update on a distribution site for other computers to access. 

To upload the update module to a distribution site, select the Store 
Update Module In checkbox. Enter a location for the distribution site or 
click Browse to choose a location. 

4. Complete one of the following steps:

� To perform the update now, click Update Now. 

Response : AutoUpdate begins downloading the latest update. 
Once the update is complete, click OK to return to the Console.

� To schedule AutoUpdate, click the Schedule tab.

Response : The Schedule page appears. Continue to the next 
step.

5. Select when or how often AutoUpdate will update its data files. When 
finished, click OK to save the configuration and return to the Console.

" If you selected Daily, be sure to specify which days you want the 
update to occur. To select the days, click Which Days.
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Creating a Script

Obtaining updates from outside your network typically requires you to create a 
script. Once created, AutoUpdate can be configured to execute the script auto-
matically. 

" This section will not instruct you on how to write a script. If you do not know 
how to write a script, consult a programmer.

The sample script works by creating a temporary file, which contains the 
parameters required by ftp to obtain the update. These include the ftp site 
name, the user name, the binary file transfer, the file %1 (%1 is either VER-
SION.DAT or the update filename, as specified by AutoUpdate), and the quit 
parameters.

This following script is notated with information explaining the function of each 
line. 

" This script will not work without modification. 

@echo off
rem *****  FTPGET.CMD                                 *****
rem *****  Copyright (C) 1996 McAfee Associates Inc.  *****
rem *****  This script will download file specified   *****
rem *****  on the command line from mcafee.com        *****
rem *****  /pub/updates directory                     *****
rem *****  errors and status information will be      *****
rem *****  logged into FTPGET.LOG in the current      *****
rem *****  directory                                  *****

rem Create FTP command file FTPCMD.FTP
echo open>FTPCMD.FTP
Creates the file FTPCMD.FTP and adds “open” to the file.
echo ftp.mcafee.com>>FTPCMD.FTP
Adds the ftp site name to FTPCMD.FTP.
echo ftp>>FTPCMD.FTP
Adds the ftp command to FTPCMD.FTP.
echo %USERNAME%@%USERDOMAIN%>>FTPCMD.FTP
Adds the user name needed to log on to the site to FTPCMD.FTP.
echo bin>>FTPCMD.FTP
Adds bin to FTPCMD.FTP. Indicates binary file transfer.
echo get /pub/updates/%1>>FTPCMD.FTP
Adds the filename to get to FTPCMD.FTP. Passed as %1 by AutoUpdate. 
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The update path is subject to change. Contact McAfee for the latest update location.
echo close>>FTPCMD.FTP
Closes the file FTPCMD.FTP.
echo quit>>FTPCMD.FTP
Closes the ftp connection.

rem Now launch ftp.exe with the command file FTPCMD.FTP
ftp -s:FTPCMD.FTP >> FTPGET.LOG
Launches FTP.EXE with the appropriate command line parameters configured in 
FTPCMD.FTP.

rem Now delete FTPCMD.FTP
del FTPCMD.FTP > nul
Deletes FTPCMD.FTP.

rem We're done
The update is download and the ftp session is closed.

Scheduling AutoUpdate

For a server to receive updates, it must be scheduled to request them. 
AutoUpdate can request updates:

� Once

� Hourly

� Daily

� Weekly

� Monthly

� At Startup

To schedule AutoUpdate, complete the following procedure:

Step Action

1. Click the Schedule tab of the AutoUpdate Properties window.
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Response : The Schedule property page appears (Figure 6-2).

Figure 6-2. AutoUpdate Properties Window
(Schedule Property Page)

2. Select the Enable Scheduler checkbox.

3. Select how often the server requests updates:

� To schedule GroupShield to request a one time update, select the 
Once option and enter the time and date.

� To schedule GroupShield to request an update hourly, select the 
Hourly option. Set the request to start x minutes after the hour 
where x is a number between 0 and 59. For example, to set the 
request to occur 30 minutes after every hour (8:30, 9:30, 10:30, 
etc.), select the Hourly option and enter 30 in the minutes field.

� To schedule GroupShield to request an update weekly, select the 
Weekly option and enter the time and day of the week for the 
request to start.



GroupShield User’s Guide 76

Updating GroupShield
Scheduling AutoUpdate6

� To schedule GroupShield to request an update monthly, select the 
Monthly option and enter the time and day of the month for the 
request to start.

� To schedule GroupShield to request an update at Startup, select 
the At Startup button.

� To schedule GroupShield to request an update on specific days, 
select the Daily option and enter the time for the request to start. 
Then, click the Which Days button.

Response : The Select Days to Request Updates dialog box 
appears (Figure 6-3).

Figure 6-3. Select Days To Request Updates Dialog Box

Action : Choose which days the update request will run. Click OK.

4. Click OK.

Response : AutoUpdate is scheduled to run at the specified time(s).
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The Bits and the Bytes

Computer viruses, most users know, can have a devastating impact on produc-
tivity. What many of those same users don't know is basic information that 
could help them protect themselves from infection—such as where viruses 
come from and how they operate.

In the beginning

The conceptual foundations for viruses have been around much longer than 
the virus threat itself. Although virus historians disagree on the specific whens 
and wheres, it is generally accepted that the ideas were born when computers 
were still huge and expensive—the domain of large corporations and the gov-
ernment, not the public. And while many of the viruses circulating today are 
malicious, destruction of data was not part of the original premise.

The idea was that if one could create a computer program that could make 
copies of itself, or self-replicate, it might also be possible for that program to 
evolve. If an error were to occur in the replication process, the resulting code 
(the bits of information that make up the program) would be mutant. Just as 
mutant genetic code is what disposes a biological virus to either be more or 
less able to survive and propagate, mutant digital code might dispose a com-
puter virus to be more or less able to survive in the computer environment. 
Given enough time, the logical extension of the theory goes, a computer virus 
could evolve into something approaching artificial intelligence. Science fiction 
suddenly starts to look more like science and less like fiction.
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What viruses really are

At its core, a virus is simply a program with one goal: self-replication. Part of 
achieving that goal is remaining undetected. If a virus is found by a user, it is 
likely to get deleted, which puts quite a damper on any self-replicating plans. 
Just like any other program, a virus has to be run to do its work. And since a 
user will not run a virus intentionally, the virus has to attach itself to a file that 
the user will run. That includes executable files and document files with embed-
ded macros, as we will see in a couple of pages. For a virus to infect any other 
type of file—say, a plain text file—would be counter-productive: Remember, 
replication is its primary objective.

Computers with the sniffles?

Consider the similarities between computer and biological viruses. A computer 
virus infects a host program, just as a biological virus infects a host cell. It 
writes its own code in among the pieces of code that make up the host pro-
gram. Then, in much the same way as a biological virus uses resources from 
its host organism to reproduce, a computer virus runs each time the infected 
host is run, and makes copies of itself. Those copies then infect other pro-
grams, and the cycle begins again.

Just as biological viruses have detrimental effects, so do their computer coun-
terparts. The first computer viruses were simply experiments by research sci-
entists to test the theory—to see if it could be done. They proved the theory, 
but also discovered that viruses had some unfortunate side effects. Viruses got 
in the way of some of the normal processes of the computer and caused erratic 
behavior. Many viruses are now specifically programmed to perform some 
function outside of self-replication. This function, called the payload, can be as 
innocuous as displaying a message on the computer's monitor or as harmful as 
destroying data on the system's hard disks. It is delivered when the trigger, an 
event such as a particular combination of keystrokes, a certain date or a pre-
determined number of actions, occurs.
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Who writes viruses?

The reason for this change in the behavior of viruses—from innocent experi-
ment to malicious sneak attack—is a result of a change in the type of people 
who write them. Virus code is now developed by many people who are less 
interested in studying the possibility of artificial intelligence than in inflicting 
harm. Some do it out of spite, some because they aspire to be the underground 
"mad hacker” romanticized in much of pop culture as a freedom fighter of the 
digital age. The reasons people write virus code are probably as varied and 
strange as the reasons people perform other destructive acts.

Some virus writers actually choose to identify themselves, such as the Paki-
stani brothers who wrote the Brain virus. The brothers included the name, 
address, and telephone number of their software company in the viral code. 
When the payload was delivered, this information would be displayed for the 
user. Apparently, the brothers wrote the virus to show how widespread soft-
ware pirating was. They put it on software leaving their office with the idea that 
wherever the virus spread, so had their software. Of course, what they over-
looked was the fact that the virus spread by infecting programs other than the 
one it left their office in.

Other virus writers are disgruntled employees seeking revenge. Still others are 
schoolkids who write just to see if they can. The famous Stoned virus is said to 
have been written by such a youngster. Having written it, he feared the conse-
quences of unleashing it, so he destroyed all copies of the virus except one, 
which he kept at his house. His younger brother and a couple of friends man-
aged to lay their hands on it though, and infected some disks as a joke. But the 
infection spread quickly and soon was impossible to stop.

Whatever the motivation, the number of people capable of writing a virus is 
growing right alongside the computer industry. Those who stand to be affected 
by virus infection—anyone who uses a computer—should be alert and wary.
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Only getting worse

In part, the fact that there are so many of us who need to be on the alert today 
is what makes virus proliferation possible. When the computer world was made 
up entirely of huge expensive machines, a virus did not have very far to go 
once it got started. But with the advent of the personal computer, viruses sud-
denly had a lot of places to go. The rapid growth of the Internet, the capability 
to attach files to e-mail messages, and the increasing degree to which the 
world depends on its computers all make conditions ever-better for the spread 
of computer viruses.

New developments

There are other reasons to be especially wary these days. Viruses get increas-
ingly complex and advanced as computers on the whole do the same. Just in 
the last few years, sophisticated and dangerous new virus families have 
appeared, such as polymorphic viruses and macro viruses. Polymorphic 
viruses are especially tricky because they change each time they infect a new 
file. Where once anti-virus software could search for viruses by "signatures" 
(chunks of code unique to each virus), software must now be able to detect 
polymorphic viruses that change their signature each time they infect a file.

Macro viruses infect documents and document templates—new territory for 
viruses. Documents used to be safe from viral attack because until a few years 
ago, a document file didn’t have any executable code in it. Now that software 
applications like Microsoft Word and Microsoft Excel have embedded macro 
capabilities, viruses can infect documents created by that software through the 
macro language.

All that just in the last few years. And viruses as a serious threat have only 
been around for about ten years. To imagine what is in store as the computer 
becomes more complicated and more a part of everyday life is frightening. 
Luckily, you have purchased the best protection against infection available 
today. And with McAfee's outstanding support and worldwide anti-virus 
research teams, you can make sure your protection keeps up with the ever-
changing computer world.
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If You Have or Suspect You Have a Virus

If you suspect your system is infected with a virus prior to installing Group-
Shield or if GroupShield encounters a virus and prompts you to shut down your 
system, complete one of the following procedures:

� If you can get into the system, see “If you can get into the system,” follow-
ing.

� If you cannot get into the system, see “If you cannot get into the system” on 
page 82.

If you can get into the system

" Due to the nature of some viruses, it may not be possible to restart your 
system once the viruses are removed. If you can get into your system, it is 
highly recommended to perform a backup prior to using the Emergency 
Disk.

Step Action

1. Backup your system using a fresh tape.

2. Shut down the system.

3. Place the Emergency Disk in the A: drive.

" Make sure the BIOS is set to boot from the A: drive first.
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4. Turn the computer on.

5. Follow the on-screen instructions and remove any viruses found.

� If the Emergency Diskette removes the viruses, continue to the 
next step.

� If Emergency Diskette does not remove the viruses, use the McA-
fee Website to find information on manually removing viruses. See 
“How To Contact McAfee” on page 11.

" If you are using a NTFS (New Technologies File System) partition, 
it will not be visible to the Emergency Disk. This procedure only 
eliminates viruses on the Master Boot Record (MBR) or boot sec-
tor of visible DOS partitions. 

6. Restart the system.

7. Install GroupShield. For information on installing GroupShield, see 
“Performing a Single Server Installation” on page 16. 

If you cannot get into the system

If you cannot get into the system, it may be helpful to use the Windows NT 
Installation Diskettes with the Emergency Disk created by Microsoft’s RDISK 
utility. To repair the system area, complete the following procedure:

Step Action

1. Turn the machine off.

2. Insert the Windows NT Installation diskette into the A: drive.

" If you do not have these diskettes or did not create the Emergency 
diskette with the RDISK utility, you can try scanning the system 
with a generic boot diskette. To create one, format a diskette on 
another Windows NT machine and copy the following files: NTDE-
TECT.COM, NTLDR.COM, BOOT.INI, AND NTBOOTDD.SYS 
(SCSI systems only).
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3. Start the system.

4. Follow the instructions for repairing a Windows NT installation.

5. Restart the system.

� If the system restarts, see “If you can get into the system” on 
page 81.

� If the system doesn’t restart, continue to the next step.

6. Reinstall Windows NT. 

7. Load the most recent backup files.
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New viruses (and variants of old ones) are constantly appearing and circulating 
throughout the personal computer community. McAfee updates the programs 
regularly—usually monthly, but sooner if many new viruses appear. Each new 
version detects and removes as many as 200 new viruses. To find out what’s 
new, read the WHATSNEW.TXT text file that shipped with this product.

Downloading new versions

Download the latest virus definition data (DAT) files from the McAfee website, 
www.mcafee.com, or from another of McAfee’s online services. For more infor-
mation, see “How To Contact McAfee” on page 11.

To update your DAT files, complete the following steps:

Step Action

1. Create a new directory for the downloaded file.

2. Copy the file to the new directory.

3. Double-click the file.

Response : The WinZip dialog box is displayed.

Action : Click Extract.

Response : The files are unzipped.
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" If the files do not unzip and the procedure does not work properly, 
see the McAfee Web Site for information on downloading and 
using Pkunzip and WinZip. For information about the McAfee Web 
Site, see “How To Contact McAfee” on page 11.

4. Copy the files NAMES.DAT, CLEAN.DAT, and SCAN.DAT to the 
GroupShield program directory. The default directory location is shown 
below.

" Always download and decompress the files in a separate directory 
from your current files. 

5. Before performing any scans, shut down your server, wait a few sec-
onds, and turn it on again. GroupShield may report a “failed integrity 
check” if you attempt a scan immediately after an update.

Validate the program files

When you download a program file from any source other than the McAfee bul-
letin board or other McAfee service, it is important to verify it is authentic, unal-
tered, and uninfected. McAfee anti-virus software includes a program called 
Validate, which ensures your version of GroupShield is authentic. When you 
receive a new version of GroupShield, follow Validate’s instructions to ensure 
successful verification of all program files. See README.1ST for more infor-
mation on the Validate program.

x:\Win32App\GroupShield NT (NT 3.5X)

X:\Program Files\McAfee\GroupShield NT (NT 
4.0)
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McAfee is pleased to offer many different types of technical assistance to cus-
tomers. These flexible support programs are designed to meet the needs of 
individuals and businesses at any level. By offering support solutions that 
range from a complimentary 90-day introductory technical support program to 
an optional one-year personal support plan, McAfee helps to ensure that you 
receive the level of technical assistance you require.

McAfee also offers a variety of technical assistance plans designed to meet the 
needs of business customers, including training, consulting, enterprise support, 
and a Jump Start program. Please review each of the different support service 
plans and benefits listed in this appendix and pick the one best suited for you.

" The term update refers only to the virus definition files; the term upgrade 
refers to product version revisions, executables, and definition files. 
McAfee offers free online virus signature file updates (.DATs) for the life of 
your product. However, we cannot guarantee backward compatibility of the 
signature files with previous versions’ executable files (.EXEs). By upgrad-
ing your software to the latest product version and latest .DAT files, you 
ensure complete virus protection for the term of your software subscription 
or maintenance plan.
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Customer Service Programs

Free introductory support program

All registered owners of single-node (one computer) products, such as those 
purchased at local retail stores or those downloaded from McAfee Store on our 
website, are entitled to:

� Free online virus signature (.DAT) file updates for the life of the product.

� One year of free online product upgrades (product version revision) with 
the newest features with a VirusScan Classic purchase; two years of free 
online product upgrades with a VirusScan Deluxe purchase.

� Free support services listed below.

Support services 

� Electronic and online support, available 24 hours a day, seven days a 
week on each of the forums listed below:

� Automated voice and fax system: (408) 988-3034

� McAfee BBS (electronic bulletin board system): (408) 988-4004

� World Wide Web site: http://www.mcafee.com

� CompuServe: GO MCAFEE

� Microsoft Network: MCAFEE

� America Online: keyword MCAFEE

� Technical support phone assistance, available during regular business 
hours, 6:00 A.M.– 6:00 P.M. Pacific time, Monday through Friday, for 90 
days. To receive support, contact our professionally-trained support repre-
sentatives at one of the following numbers:

� For corporate-licensed customers: (408) 988-3832

� For retail-licensed customers: (972) 278-6100
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To receive your free online upgrades, please refer to the download instructions 
included in the box or contact our Customer Care department at (408) 988-
3832. Please supply your proof of purchase when you request the upgrade. 
You will be given a password to the upgrade area on either the McAfee BBS, 
FTP site, or World Wide Web site so that you can download a registered ver-
sion of the latest product.

Free subscription maintenance and support program

McAfee offers all registered owners of licensed multiple-node (ten computers 
or more) subscription products the following free support services and mainte-
nance during the two-year term of the software subscription.

" You must be registered to receive these services.

Support services 

� Electronic and online support, available 24 hours a day, seven days a 
week on each of the forums listed below:

� Automated voice and fax system: (408) 988-3034

� McAfee BBS (electronic bulletin board system): (408) 988-4004

� World Wide Web site: http://www.mcafee.com

� CompuServe: GO MCAFEE

� The Microsoft Network: MCAFEE

� America Online: keyword MCAFEE

� Technical support phone assistance during regular business hours, 6:00 
A.M.–6:00 P.M. Pacific time, Monday through Friday, from our professionally 
trained support representatives at (408) 988-3832.

� Two years of free online product upgrades with the newest features and 
virus definition data. If you upgrade your operating system, you can also 
extend the upgrade of your McAfee product to the new platform.
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Optional support plans

" Contact McAfee for current pricing structures.

Option 1: One-year personal support plan

For registered owners of single-node products who want to extend their sup-
port coverage, this plan allows you to call in for unlimited technical support, 
download the latest virus protection updates each month, and periodically 
download upgrades from any of McAfee’s registered online services—all for a 
full year. If you upgrade your operating system, you can also upgrade your 
product program to the new platform.

Option 2: One-year quarterly disk/CD-ROM maintenance and 
support programs

This plan is for registered owners of either single- or multiple-node subscription 
products. It offers all the features of Option 1, while adding a quarterly mailing 
of software upgrade diskettes or CD-ROMs (depending on the product) and a 
quarterly update newsletter. With this option, you can update your product to 
include the latest features and virus data files without having to download from 
an online service.

Each optional support plan begins as soon as you purchase the product and is 
good for one year, at which time you can renew your support program through 
McAfee’s Customer Care department at (408) 988-3832. 

" McAfee reserves the right to change part or all of its Customer Service Pro-
grams at any time without notice.
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Professional Services Programs

McAfee Professional Services provide a wide range of on-site services. 
Whether for short-term assistance or long-term strategic planning, a highly 
qualified consultant can help you achieve positive results. McAfee consultants 
are trained on NetWare, Microsoft NT Advanced Server, Windows 95, and a 
multitude of desktop applications. 

Before work begins, a project manager discusses the project scope and objec-
tive with you and comes to a mutual agreement on the job objective. When the 
consultant leaves the site, you can be sure that the objective has been 
achieved.

Training

McAfee’s expertise and experience is available to your personnel, allowing an 
organization to take full advantage of its computing resources. McAfee offers 
on-site training on all McAfee products, network management seminars, anti-
virus seminars, customized curriculums for site-specific applications as well as 
product and personnel certification. McAfee’s consultants provide extensive 
training with curriculum tailored to your organization’s needs.

Consulting

McAfee Professional Services offer a number of hourly and daily consulting 
services including:

� Troubleshooting an existing installation

� Writing PowerScript or SaberBASIC scripts

� Planning and designing networks

� Installing and configuring McAfee products

� Configuring Windows 95

� One-on-one consulting

McAfee Professional Services are available on a quotable time and materials 
basis to perform project management, product research, and a number of other 
consulting services.



GroupShield User’s Guide 91

McAfee Support Services
Professional Services ProgramsD

Jump Start program

This fixed-fee consulting program is designed to get clients up and running on 
McAfee products as soon as possible. It includes training, installation, and con-
figuration services as needed on a single server. It is designed to demonstrate 
how to connect various PCs to the LAN, train administrators how to use the 
program, and master the roll-out process.

Enterprise support

McAfee’s Enterprise Support Program provides customers with the highest 
level of support possible. This fee-based program is designed for those corpo-
rate customers who need a higher level of personal service.

The Enterprise Support Program offers the following features:

� Direct pager number to your assigned senior Enterprise Support Program 
analyst

� Extended support hours: 7:00 A.M. to 7:00 P.M. central time, Monday 
through Friday

� Five designated McAfee contacts

� Proactive support, providing updated company and product information as 
it becomes available

� On-site services at a 25% discount

� VIP issues review list

� Beta site (if desired)

Every Enterprise Support Representative calls clients each week. This phone 
call is used to forward any information such as technical notes and application 
anomalies of which you should be aware. This call also ensures that you have 
no unresolved problems or complications with the product. Enterprise Support 
representatives will return your page on the day it is received.
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Optional 7 x 24 enterprise support 

Frequently, customers are responsible for their own LANs, which run 24 hours 
a day, seven days a week. This feature offers round-the-clock support for cli-
ents requiring support outside normal business hours.

" McAfee reserves the right to change part or all of its Professional Services 
Programs at any time without notice.
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Alert Message Variables

Alert messages generated by GroupShield may contain the following variables:

� %FILENAME% - Name of the infected file

� %TASKNAME% - Name of the task that detected the virus

� %VIRUSNAME% - Name of the virus

� %USERNAME% - Name of the user reporting the event

� %COMPUTERNAME%- Name of the computer reporting the event

� %SOFTWARENAME% - Software product reporting the event

� %SOFTWAREVERSION% - Version of the software reporting the event

� %DATE% - Date of the event

� %TIME% - Time of the event

� %SENDER% - Name of the message sender (MAPI alerting only)

� %RECIPIENT% - Name of the message recipient (MAPI alerting only)
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Centralized Alerting ALR File Format

The ALR file is a text file that contains Centralized Alerting virus event vari-
ables. Each variable in the file has a name followed by the equal (=) sign and a 
value. The following is a line-by-line description of the Centralized Alerting ALR 
file format:

Variable Description

[CentralAlert] Centralized Alerting identifier

uFileVersion Type: Integer

Centralized Alerting version number

uStatus Reserved

szVirusName Type: String 

The name of the virus

szItemName Type: String 

The infected file name and path

szUserName Type: String 

The user name

szSoftware Type: String 

The name of the McAfee virus application 
installed on the reporting machine

szSoftwareVersion Type: String 

The version of the virus application

szComputerName Type: String 

The name of the machine reporting the event

uYear Type: Integer (0000-9999)

The year of the event

uMonth Type: Integer (1-12)

The month of the event

uDay Type: Integer (1-31

The day of the event

uHour Type: Integer (0-23)

The hour of the event
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uMinute Type: Integer (0-59)

The minute of the event

uSecond Type: Integer (0-59)

The second of the event
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